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Chapter 1

Getting started

This chapter helps you install and run MuseScore for the first time. The
chapter will also show you how to create a new score.

Installation

MuseScore works on many different computer systems including, Windows,
Mac OS, and Linux.

Windows

You can get the Windows installer from the Download page of the MuseScore
website. Click on the link to start the download. Your Internet browser will
confirm that you want to download this file. Click "Save File".

When the download finishes double click on the file to start the installation.
Windows may open a security window and ask you to confirm before running
the software. Click "Run" to continue.

(7 MuseScore 0.9 Setup =] = |

Welcome to the MuseScore 0.9
Setup Wizard

This wizard will guide you through the instalation of
MuseSoone 0.9,

Tt is recommended that you dose all other spplications

before starting Satup. This wil make it possible to update
relevant system flies without having to reboot your
computer,

Chick Mext to continue.
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The installer recommends that you close all other applications before
continuing. After you close the other applications click "Next" to continue.

The setup wizard displays the terms of the free software license which you
may review. Click "I Agree" to continue.

Next it confirms the location for installing MuseScore. If you are installing a
newer version of MuseScore but still want to keep the old version on your
computer then you should change the folder. Otherwise click "Next" to
continue.

Next it confirms the name for the MuseScore folder that appears in the
Windows Start menu list of programs. Click "Install" to continue.

Give the setup wizard a few minutes to install the necessary files and
configurations. When it is done click "Finish" to exit the installer. If you wish,
you may now delete the installer file you downloaded.

L7 MuseScore 0.9 Setup

Completing the MuseScore 0.9
Setup Wizard

MuseSeane 0.9 has been installad on your computer,

Click Finish to dose this wazand.

L=

Start MuseScore

To start MuseScore choose Start —» All Programs - MuseScore - MuseScore.

After several seconds MuseScore will open up to the demo score. Feel free to
experiment with the demo score and get the feel of the program. Next you
may want to create your own score.
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Advanced users : Silent or unattended install

You can install MuseScore silently with the following command
MuseScore-0.9.6.3.exe /'S /D=C.\ Program Fi | es\ MuseScor e
You can uninstall with

cd C \Program Fil es\ MuseScor e

Uninstall.exe /S

Mac 0OS X

Install

You will find the Mac dmg file on the Download page of the MuseScore
website. Click on the link to start the download. When download is finished,
the dmg file is automatically mounted on your desktop as "MuseScore-0.9.6"
and the installer appears.
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MuseScare

Applications

Drag the MuseScore icon and drop it to the Applications folder icon. If you
are not logged in as an administrator, Mac OS X will ask for a password:
click "Authenticate" and enter your password to let Mac OS X copy
MuseScore into your Application folder.

You can now launch MuseScore from Applications or SpotLight.

Uninstall

Just delete MuseScore from Applications folder.

Linux

Please see the Download page for instructions pertaining to MuseScore on
Linux. Packages are provided for Debian, Ubuntu, Fedora and PCLinuxOS.
Other distributions will require you to build the application from source. For
instructions specific to Fedora see below.

Fedora
Import the GPG key:

su
rpm--inport http://prerel eases. nusescore. org/linux/Fedora/ RPM GPG KEY- Seve
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2. Go to the download page of the MuseScore website. Click on the link for
the stable Fedora download and choose the correct rpm package for your
architecture

3. Depending on your architecture, use one of the two sets of commands
to install MuseScore

if for arch i386

su
yum | ocal i nstall nusescore-0.9.4-1.fc10.i386.rpm

or if for arch x86 64

su
yum | ocal i nstall rnusescore-0.9.4-1.fc10.x86_64.rpm

If you have difficulty with sound, see Fedora 11 and sound.

Create new score
From the main menu choose File » New.... This opens the new score wizard.

Title, composer and other information

.~ MuseScore: Create New Score 2 X
Create New Score c?
This wizard creates a new score
:F Title: Bilder einer Ausstellung
ik .. Subtitle: | Promenade
i_é Composer: |Mode5te Moussorgsky
! Poet:

7 Copyright:

==
e,

Create new score from template

» Create new score from scratch

—
= Back | Next>| Cancel

Enter the title, composer, or any other information as shown above. Notice
the two options at the bottom:

¢ Create new score from template

¢ Create new score from scratch

The first option offers a list of ready-made scores in the next screen. The
second option gives you the full choice of instruments in the next screen.


http://musescore.org/en/download
http://www.musescore.org/en/node/3848#comment-9634

Templates are discussed in more detail below, but for now choose "Create
new score from scratch."

Click "Next" to continue.

Instruments and voice parts

.~ MuseScore: Create New Score 2 X%

Create New Score ]
Define a set of instruments. Each instrument is represented by one

of more staves

Instrument List |SIBVE$ |C|ef

= Woodwinds

o Brass Add Sta... Treble Clef ...
o Percussion Rennove Sta... Bass Clef (...

o Guitars

| = Wocals
Keyboards
* up
| Harpsichord Do
Organ
Rock Organ
Accordian
& PluckedStrings Add Above

o Strings
Add Below

< Back MNext> Cancel

The instrument window is divided into two columns. The first column lists
instruments or voice parts to choose from. The second column is initially
empty but will soon contain a list of the instruments for your new score.

The instrument list in the first column is categorized into instrument
families. Double click a category to show the full list of instruments in each
family. Select an instrument and click "Add". The instrument you selected
now appears in the second column. You can add more instruments or voice
parts if needed.

The order of the instruments in the second column determines the order they
appear in the score. To change the order click on an instrument name and
use the "Up" or "Down" buttons to move it higher or lower. When you are
done click "Next".

Key signature

If you are using the latest version of MuseScore the wizard asks for a key
signature. Select the key signature you need and click "Next" to continue.

If you are using version 0.9.2 or earlier the wizard does not ask for a key
signature so you may ignore this step.

Time signature, pickup, and number of measures



-~ MuseScore: Create New Score 2 X%
Create New Score e
Create Time Signature

/____I Enter Time Signature;
| Time Signature: |4 =L

|
=1 %; Pickup Measure

Time Signature |4 = 1 =

Enter Number of Measures:

']
| Measures: |12 =
1 Hint: you can also add or remove measures after creation of the score

—
< Back | Finish Cancel

Set the time signature to the numbers you want. If your piece begins with a
pickup then mark the "Pickup measure" checkbox and adjust pickup time
signature to indicate the actual duration of the first measure.

If you know approximately how many measures you need you can specify
that here. Otherwise you can add or delete measure later.

Click "Finish" to create your new score.

Adjustments to score after creation

You can change any settings specified during the new score wizard even
after you start working on the score.

e To add or delete measures or create a pickup see Measure operations

* To change any text see Text editing. To add a missing Title (or other text
item) use the menu Create —» Text - Title (or other text item)

* To add, delete, or change the order of instruments use the menu Create —»
Instruments....

See also: Key signature, time signature, clef.

Templates

The first screen of the new score wizard has an option to "Create new score
from template" (see Title and other text above for details). To create a score
using this method select the template option and click "Next" to continue.

The next screen shows a list of templates. Select a template and click "Next".
Continue and finish the new score wizard as usual.

The template files are normal MuseScore files stored in the template folder.
You can create your own templates by saving MuseScore files to the
template folder. On Windows the template folder is usually located at
C:\Program Files\MuseScore\templates. On Linux look under



/usr/share/mscore-xxx if you installed from the package manager. If you
compiled mscore on Linux then look under /usr/local/share/mscore-xxx. On
Mac look under /Applications/MuseScore.app/Contents/Resources/templates



Chapter 2

Basics

The "Getting started" chapter above guides you through the Installation and
process for creating a new score. The "Basics" chapter gives an overview of
MuseScore and describes the general methods for interacting with the score.

Note entry

Adding notes and rests to a staff requires four basic steps:

1. Select your starting position for note entry

2. Select Note entry mode

3. Select the duration of the note (or rest) you want to enter
4

. Enter the pitch (or rest) using keyboard shortcut, mouse or a MIDI
keyboard

Step 1: Starting position

First select a note or rest on the score as your starting position for note
entry. Note entry in MuseScore replaces the existing notes or rests in a

measure with your new notes (i.e. overwrites rather than inserts). However
you can insert new measures at any point (see measure operations, "Insert")

or use copy and paste to move a passage of notes.

Step 2: Note entry mode

The "N" button on the Note Entry toolbar indicates whether you are in note

entry mode or not. Besides clicking the button you can using the following
keyboard shortcuts.

* N: Enter Note entry mode

* N or Escape: Leave Note entry mode

10



Step 3: Duration of the note

After entering Note entry mode select the duration of the note you need from
the Note Entry toolbar or use the corresponding keyboard shortcut.

In version 0.9.4 and later the keyboard shortcuts for selecting the note
duration are:

e 1: 64th note (hemidemisemiquaver)

: 32nd note (demisemiquaver)

.
W N

: 16th note (semiquaver)

* 4: Eighth note (quaver)

e 5: Quarter note (crochet)

¢ 6: Half note (minim)

* 7: Whole note (semibreve)

* 8: Double whole note (breve)

* 9: Longa

.: A period (dot) changes the selected duration into a dotted note

In version 0.9.3 or earlier the note duration shortcuts involve two keys:

e Alt+1: Quarter note (crochet)

e Alt+2: Eighth note (quaver)

e Alt+3: 16th note (semiquaver)

e Alt+4: 32nd note (demisemiquaver)

* Alt+5: 64th note (hemidemisemiquaver)
e Alt+6: Whole note (semibreve)

e Alt+7: Half note (minim)

.2 A period (dot) changes the selected duration into a dotted note

Step 4: Enter pitch

For all instruments (except unpitched percussion) you can add note pitches
using the mouse by clicking directly on the staff. (For instructions specific to
percussion see Drum notation). However you may find it quicker to use a
MIDI keyboard (see below) or your alphabetical keyboard. The following
examples use a standard computer keyboard.

Enter pitches by typing the corresponding letter on your keyboard:

CDEFGABC
C D E F G A B C

s 4 ° F

L 1HEN

G =

=

11



0 (Zero) creates a rest: for example € D 0 E. Notice that the duration you
select for the notes (quarter/crochet notes in this example) also determines
the duration of the rest (quarter/crochet rest)

'

r

o
ol
L

| 0SS

Please note that in versions 0.9.6 and earlier, Space creates a rest. In the
latest versions of MuseScore Space starts playback.

During note entry MuseScore automatically advances in the score. If you
want to add a chord note to your previous entry, hold shift and enter a note

name: C D Shift+F Shift+A E F

BEES

To create chords with notes of different durations see voices.

If you want to create a dotted note, press .. For example 5. C 4 D E F G A (Note:
versions 0.9.3 or earlier use different keyboard shortcuts to change note
duration. See section above for more information)

— T
@_J_;L._JHL_L

When you type a note on the keyboard MuseScore chooses the octave closest
to the previous note to entered. To shift your note up or down by an octave
use the following keyboard shortcuts:

e Ctrl+1 (Mac: #+1): Increase the pitch of a note by one octave.

e Ctrl+! (Mac: ¥+1): Decrease the pitch of a note by one octave.

Other useful editing keyboard shortcuts available in Note Entry Mode:

* 1 (Up): Increase the pitch of a note by a semitone (uses sharps).
* | (Down): Decrease the pitch of a note by a semitone (uses flats).
e R: Duplicate the last entered note

* Q: Halve the duration of the last entered note

e w: Double the duration of the last entered note

e Backspace: Undo last entered note

» X: Flip direction of note stem

* Shift+X: Move note head to opposite side of stem

MIDI keyboard

You can also insert pitches using a MIDI keyboard in MuseScore version
0.9.6 or later. Version 0.9.3 or earlier has support for MIDI keyboard on
Linux only.

12



1. Connect your MIDI keyboard to the computer and switch your keyboard
on

2. Start MuseScore
3. Create a new score

4. Click to select the rest in measure 1 to indicate where you want note
entry to begin

5. Press N to begin note entry mode

6. Select a note duration such as 5 for quarter notes (crochets), as
described above

7. Press a note on your MIDI keyboard, and notice that the pitch is added
to your score

Note: the MIDI keyboard enters one note or chord at a time. This mode of
note entry (often called "step-time entry") is fast and reliable. Some notation
software tries to interpret "real-time entry" where the musician plays a
passage and the software tries to create the notation. However the results
are frequently unreliable even when played by a skilled musician using
expensive software. MuseScore's focus is on more reliable forms of note
entry.

If you have multiple MIDI devices connected to your computer you may need
to tell MuseScore which one is the MIDI keyboard. Using version 0.9.6 or
later go to Edit —» Preferences... (Mac: MuseScore - Preferences...). In the
preferences dialog click on the //0 tab and select your device under the
section labeled "Choose PortMidi input device".

Coloring of notes out of playable range

MuseScore colors out-of-range notes as yellow or red in versions 0.9.5 or
later. Notes above or below the comfortable range of an amateur appear
yellow, note beyond the comfortable range of a professional appear red. The
colors are informational and appear on the computer screen but do not
appear on printed copies of your scores. To disable note colors in versions
0.9.6 or later choose Edit —» Preferences... (Mac: MuseScore - Preferences...), click
on the Note Entry tab, and unmark "Color notes outside of usable pitch
range".

See also

e Drum notation

External links

e Video tutorial: Note entry basics

13
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Copy and paste

MuseScore can copy individual notes or large selections of music. The 0.9.4
release includes many improvements to copy-paste including support for
shift-drag selections. Copy-paste in versions 0.9.3 or earlier is limited to full
measures and difficult to use (see below for instructions).

Copy

1. Click on the first note of your selection

2. Shift+click on the last note of your selection. A blue rectangle should
highlight the region you selected.

3. From the menu choose Edit » Copy

Paste

1. Click on the note or measure that you want your pasted selection to
begin

2. From the menu choose Edit —» Paste

Instructions for 0.9.3 or earlier

Copy

1. Click on an empty part of a measure to select the entire measure (a blue
rectangle highlights the selection)

2. If you want to extend the selection then Shift+click on the empty part of
another measure

3. From the menu choose Edit -» Copy

Paste
1. Click on the empty part of the measure you want to paste into

2. From the menu choose Edit - Paste

Edit mode

Many elements in the score can be edited in Edit Mode :

e Double Click: Starts Edit Mode
* Escape: Ends Edit Mode

Some elements show handles in edit mode which can be moved by mouse
dragging or keyboard commands.

14



Slur in Edit Mode:

Available keyboard commands:

* «: Moves handle left one Space

.
{

: Moves handle right one Space

¢ 1: Moves handle up one Space

* |: Moves handle down one Space

* Ctrl+« (Mac: $#+<): Moves handle left 0.1 Space

e Ctrl+- (Mac: #+-): Moves handle right 0.1 Space
e Ctrl+1 (Mac: ¥+1): Moves handle up 0.1 Space

e Ctrl+! (Mac: #+1): Moves handle down 0.1 Space
* Shift+«: Moves handle's tick anchor left

* Shift+-: Moves handle's tick anchor right

e Tab: Goes to next handle

See also: Text editing, Slur, Bracket, Line

Measure operations

Append

To add a measure to the end of the piece press Ctri+8 (Mac: $#+B), or from the
menu choose Create » Measures - Append Measure. To add multiple measures
press Ctrl+Shift+B (Mac: ¥#+Shift+B) or use the menu Create -» Measures — Append
Measures....

Insert

First select a measure then press /ns or use the menu Create - Measures -
Insert Measure to insert a new empty measure before the selected one. To
insert multiple measures press Ctri+ins (Mac: $#+Ins) or use the menu Create —»
Measures — Insert Measures....

Delete

First select the measure then press Ctri+Del (Mac: ¥+Fn+Backspace).

For 0.9.5 and earlier, it's different. Press ctr/ (Mac: %) on the keyboard as you
click on an empty part of the measure with the mouse. The measure is
marked with a dotted line indicating that you selected a "piece of time".
Press ctri+Click (Mac: #+Click) to extend the selection. Pressing De/ (Mac:
Fn+Backspace) removes the selected measures.

15



Properties

To edit the properties of a measure right click on an empty part of the
measure and select Measure Properties....

[@' MuseScore: Measure Properties l]]
i —— StvEd
Staff Viskig Siemiess
/—_ [-. O
| }
M 2 :
—
:z’— Mizagure Duration
Hominal: (6 3/ 4 &
7 Actugl: |6 2 [ 4 =
I Other
[} |
) ireguler [[] Break multi measure rest
L ! Add to measure no.: 0 3
Lawout stretch: Lo cal
Repeat count:
ﬂ | | —

Staves

The Visible property allows you to show or hide the notes and staff lines for
the current measure. The Stemless property allows you to show or hide all
note stems for the current measure. Notes that normally have a stem such as
half notes (minums) and quarter notes (crotchets) only show the note head
when marked as stemless.

Duration

The Nominal duration is the time signature that is displayed on the score.
You can change the Actual duration of a measure to anything regardless of
the time signature displayed on the score. Normally the nominal and actual
duration of a measure is identical. However a pickup (upbeat) measure for
example can have a shorter actual duration.

In the figure below the quarter note (crochet) pickup has a nominal measure
duration of 4/4 but an actual duration of 1/4. The measures in the middle
have both nominal and actual durations of 4/4. The complimentary measure
with only a dotted half note (dotted minim) at the end has an actual duration
of 3/4.

™
T

| 108
8

Irregular

An "irregular" measure is not counted in the measure numbering. Normally a
pickup measure is marked as "irregular". If you are using version 0.9.4 or
earlier and mark a measure as irregular then you may need to save and
reload the score before the measure numbers show the change.

Add to measure number
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You can also use the "add to measure no." option to influence the measure
numbering. You can enter positive or negative numbers here. Please note
that this affects subsequent measures. A value of "-1" has the same effect as
marking a measure irregular.

Layout stretch

You can increase or decrease horrizontal space between notes with this
option.

Repeat count

If the measure is the end of a repeat you can define how often the repeat
should be played.

Break multi-measure rests

This property separates a multi-measure rest at the current measure. This
option should be checked before you turn on the "Create multi-measure
rests" option in Style —» Edit General Style.

Versions 0.9.6 and later automatically break multi-measures at important
breaks such as rehearsal marks, time changes, double bar lines, etc.

Numbering

MuseScore automatically numbers the first measure of each system but
more numbering options are possible. From the main menu choose Style —»
Edit Style. In the left pane choose "Numbers". In the bottom half of the right
pane is the "Measure Numbers" ("Bar Numbers") section.

Mark the checkbox next to the "Measure Numbers" ("Bar Numbers") to turn
on automatic measure numbers.

Mark "show first" if you want the first measure numbered.

Mark "all staffs" if you want numbers on all staffs, otherwise only the top
staff of each system shows measure numbers.

Choose to show numbers on "every system" which numbers the first measure
of each line, or show numbers by "interval" and specify the size of the
interval. For example, an interval of 1 numbers every measure; an interval of
5 numbers every fifth measure.

Palette

You can show or hide the palette using the menu Display — Palette.
You can drag-and-drop palette symbols onto score elements.

Double clicking a palette symbol is equivalent to drag-and-dropping this
symbol to each of the selected elements on the score.

For example you can quickly add tenuto marks to a group of notes:

17



1. Select notes

2. In the Articulations/Ornaments palette, double click on the tenuto
symbol

Undo and redo
MuseScore has unlimited undo/redo functions.
The standard shortcuts are:

e Undo ctri+z (Mac: ¥%+2)

e Redo ctri+Shift+Z or Ctrl+Yy (Mac: $+Shift+2)

Or use the toolbar buttons:

) &

File format

MuseScore supports a wide variety of file formats, which allows you to share
and publish scores in the format that best meets your needs. You can import
files via File - Open... and export via File » Save As.... In addition to the formats
detailed below, you can save and share your scores on the web at
MuseScore.com File » Save Online....

MuseScore native format
Compressed MuseScore format (*. nscz)

MSCZ is the standard MuseScore file format and recommended for most
uses. A score saved in this format takes up very little disk space but
preserves all the necessary information. The format is a ZIP-compressed
version of . nscx files and includes images.

MuseScore format (*. mscx)

MSCX is the uncompressed version of the MuseScore file format used in
version 0.9.5 or later. A score saved in this format will not lose any
information except images and is recommended if you need to manually
edit the file format using a text editor. Previous versions of MuseScore
used the MSC file extension. However MSC conflicts with a file extension
used by Microsoft Windows and is blocked by some email providers. The
new MSCX file extension supersedes the old MSC file extension due to
the problems outlined above.

18
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Note: MuseScore does not embed fonts in the file. If you want to share a
MuseScore file with other parties choose a font for your text that the other
parties have installed. When a computer does not have the fonts specified in
the file, MuseScore uses a fallback font instead. Of course the fallback font
will look different.

Print and read (Export only)
PDF (*. pdf)

Portable Document Format (PDF) is ideal for sharing your sheet music
with others who do not need to edit the music. Most computer users
already have a PDF viewer on their computer so they will not need to
install any extra software to see your score.

PostScript (*. ps)

PostScript (PS) popular as a page description language used in
professional printing.

PNG (*. png)

Portable Network Graphics (PNG) is a bitmap image format widely
supported by software on Windows, Mac OS, and Linux. The image
format is particularly popular on the web. As of version 0.9.3 multi-page
scores export a PNG file for every page. MuseScore creates images as
they would appear on the printed page. If you want to create images that
show screen-only items such as frame boxes, invisible notes, and
out-of-range note colors then go to Edit —» Preferences... (Mac: MuseScore -
Preferences...) click on the Export tab and mark "Screen shot function"
check box.

SVG (*. svg)

Scalable Vector Graphics (SVG) can be opened by most web browsers
(except Internet Explorer) and most vector graphics software. However
most SVG software does not support embedded fonts so the appropriate
MuseScore fonts must be installed to view these files correctly.

Listen (Export only)

WAV Audio (*. wav)

WAV (Waveform Audio Format) is an uncompressed sound format
developed by Microsoft and IBM but widely supported by software for
Windows, Mac OS, and Linux. This is an ideal format for creating CDs
since no sound quality is lost in the process of saving the file. However
the large file sizes make it difficult to share via email or the web. This
export option is available in version 0.9.5 or later.
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FLAC Audio (*. fl ac)

Free Lossless Audio Codec (FLAC) is compressed audio format. FLAC
files are approximately half the size of uncompressed audio and just as
good quality. Windows and Mac OS do not have built-in support for FLAC
but software such as VLC media player can play FLAC files on any
operating system. This export option is available in version 0.9.5 or later.

Ogg Vorbis (*. ogg)

Ogg Vorbis is intended as a patent-free replacement for the popular MP3
audio format. Like MP3, Ogg Vorbis files are relatively small (often a
tenth of uncompressed audio) but some sound quality is lost. Windows
and Mac OS do not have built-in support for Ogg Vorbis. However
software such as VLC media player and Firefox 3.5 or later can play Ogg
files on any operating system. This export option is available in version
0.9.5 or later.

Share with other music software

MusicXML (*. xm )

MusicXML is the universal standard for sheet music and can be used by
most of the currently available scorewriters including Sibelius, Finale,
and more than 100 others. It is the recommended format for sharing
your sheet music between different scorewriters.

Compressed MusicXML (*. nxl )

Compressed MusicXML creates smaller files than regular MusicXML.
Compressed MusicXML is a newer standard and not as widely supported
by other scorewriters at this time.

MIDI (*. m d, *. mi di, *. kar)

Musical Instrument Digital Interface (MIDI) is a format widely supported
by sequencers and music notation software. However MIDI files are
designed for playback not score layout so they do not contain information
about formatting, pitch spelling, voicing, ornaments, articulations,
repeats, or key signatures, among other things. To share files between
different music notation software use MusicXML. If all you care about is
playback then use MIDI.

LilyPond (*. 1 y) (Export only)

LY files can be opened by Lilypond, a free scorewriter. However LilyPond
export is incomplete and experimental in the current versions of
MuseScore.

MuseData (*. nd) (Import only)

20
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MuseData is a format developed by Walter B. Hewlett beginning in 1983
as an early means of sharing music notation between software. It has
since been eclipsed by MusicXML but several thousand scores in this
format are still available on the web.

Capella (*. cap) (Import only)

CAP files are created by the scorewriter, Capella. MuseScore imports
these files fairly accurately.

Bagpipe Music Writer (*. bww) (Import only)

BWW files are created by the niche scorewriter, Bagpipe Music Writer.
This import option is available in versions 1.0 and later.

BB (*. ngu, *. sgu) (Import only)

BB files are created by the music arranging software, Band-in-a-Box.
MuseScore includes experimental support for BB import.

Overture (*. ove) (Import only)

OVE files are created by the scorewriter, Overture. This experimental
import option is available in versions 0.9.6 and later.

Share scores online

You can save and share your scores online at MuseScore.com. You can
choose to save a score privately for personal access from any computer, or
choose to share the score publicly for friends and band members to view or
download. MuseScore.com lets you view and playback scores in your web
browser and even lets you synchronize your score with a YouTube video. For
use outside of the web browser you can download the score in a variety of
formats (including PDF, MIDI, MP3, MusicXML, and the original MuseScore
file).

Create an account

1. Visit MuseScore.com and click on Create new account

2. Pick a username and enter a valid email and press "Create New
Account"”

3. Wait a few minutes for an email from MuseScore.com support. If no
email arrived, check your spam folder

4. Click the link in the email and visit your user profile to change your
password

Share a score directly from MuseScore
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You can directly save a score online from File -» Save Online.... If it's the first
time you are using this feature, you'll have to authenticate.

First time authentication
1. Go to File » Save Online...

2. MuseScore asks you to click OK to open your browser and gives
permission to MuseScore on MuseScore.com.

7i MuseScore needs your permission.. |@—E@|

MuseScore needs your permission...

MuseScore reguires permission to connect to your
MuseScore, com account. This permission is granted on
the musescore. com website so dick OK to get started.

[ OK H Cancel ]

3. Click OK and your browser opens on MuseScore.com. If you are not
logged in, enter your username and password and

4. Click "Allow Access"

5. Go back to MuseScore, and press "OK". If your browser didn't open you

can copy paste the URL into your browser address bar.
ii Ready? 2] & |

When you've given MuseScore permission to connect to musescore. com,
dick the OK button!

OK ] l Cancel

If your browser didn't open automatically, you can visit this URL, then
come badk and press the OK button.

http: ffmusescore. comfoauth fauthorize ?oauth_token=EZKdmmy

6. MuseScore is now linked to your account on MuseScore.com

Save online

After your first authentication or when you go to File -» Save Online...,
MuseScore asks you some information about your scores
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1111 Score Information B|ER

You're logged in as Nicolas [ sign out on exit

Title
Title of your score

Description

A description for your score

@ Public () Private

License |Creative Commons Attribution -

Tags tagl, tag2
Lise 3 comma fo separate the tags

[ Ok l [ Cancel

1. The title is the title of the score. You can change it

2. The description will end up next to your scores. You can describe it,
say why you wrote it etc...

3. You can choose to make your score public and everybody on
MuseScore.com will see it or private and only you will be able to see the
score.

4. Choose a license. By using a Creative Commons licence, you let people

using your scores under some restrictions.

5. You can add tags to help finding your scores on MuseScore.com. Don't
forget to use a comma to separate the tags

Upload a score on MuseScore.com

You can also upload a score directly on MuseScore.com.

1. Click the Upload link on MuseScore.com
2. You have the same options as with the Save Online menu

3. You have also access to more information such as Genre

Edit a score on MuseScore.com

If you want to make changes to one of your scores on MuseScore.com, edit
the MuseScore file on your own computer and then follow the steps below.

1. Go to the score page on MuseScore.com
2. Click the edit link

3. In the form, you can change the score file, you can also change all the
score info such as title, description etc...
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Chapter 3

Notation

In the previous "Basics" chapter you learn how to enter notes and interact
with the palette. The "Notation" chapter describes the different types of
notation in more detail including more advanced music notation.

Accidental

Accidentals can be set or changed by dragging an accidental symbol from

the accidental palette to a note in the score.
[ Accidentals -

4 x [

‘_I:ri-q—)'-lil\-d__
< ¥ 4 or

!
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¢
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Pl

If you only want to change the pitch of a note you can also select the note
and press:

—
e

* Up: Increase the pitch of a note by one semitone (favors sharps).
* Down: Decrease the pitch of a note by one semitone (favors flats).
* Ctrl+Up: Increase the pitch of a note by one octave.

* Ctri+Down: Decrease the pitch of a note by one octave.

In version 0.9.6 or later you can change an existing accidental into a
cautionary accidental (enclosed in parentheses), drag the parentheses from
the accidental palette onto to the existing accidental (not the note head). To
remove parentheses select the accidental and press Delete.
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If you later change the pitch with cursor keys, manual settings to the
accidental are removed.

The menu function Notes — Pitch spell tries to guess the right accidentals for
the whole score.

Arpeggio

Arpeggios are set by dragging an arpeggio symbol from the arpeggio
palette to a note of a chord.

SREEA

In version 0.9.5 or later you can edit the length of the arpeggio by double
clicking on it and dragging the handle up or down.

Bar line

Change bar line type

Bar lines are changed by dragging a bar line symbol from the bar line palette
to a bar line in the score.

— Bar Lines

FEEF
1= =k 3

To hide a bar line entirely right-click on the line and choose Set Invisible.

Create grand staff

To extend bar lines over multiple staves double click on a bar line to edit it
(see Edit mode).
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Click and drag the blue square down to the next staff.
Display of all staff bar lines updates when you leave edit mode.
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See also: Measure operations

Beam

Beams are set automatically but the automatic setting can be overridden
manually. Drag a beam symbol from the beam palette to a note in order to

change its beam behavior.
[ Beam Properties v]

FTITA

You can also first select a note and then double click the appropriate symbol
in the beam palette.

Start a beam at this note.
Do not end a beam at this note.

Do not beam this note.

Start a second level beam at this note (not yet implemented in current
versions of MuseScore).

See also

¢ Cross staff beaming

Bracket

Delete
Select the bracket and press Del

Add
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Drag a bracket symbol from the bracket palette to an empty space in the first

measure of a system.
[ Brackets v]

[

Change

Drag a bracket symbol from the bracket palette to an bracket in the score.

Horizontal offset

In version 0.9.4 or later you can adjust the horizontal placement of a bracket.
Double click a bracket and press Shift+Left or Shift+Right to move it left or right.

Edit
Double click on a bracket to enter edit mode, In edit mode you can drag the
height of a bracket to span arbitrary staves of a system.

Breath and pause

To place a breath symbol drag it from the breath palette to a note in the
score. The breath symbol is placed after the note. In versions 0.9.5 and
earlier the breath symbol appears before the note it was dragged to.

Breath & Pauses -
) { JI

7

Breath symbol in score:

SERERTE

Caesura (informally called tram lines or railroad tracks) work the same
way and are available in versions 0.9.6 or later.

Clef
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Clefs are created or changed by dragging a clef symbol from the clef palette
to a measure or another clef. Use F9 to show or hide the palette sidebar.

Drag a clef from the palette onto a clef in the score. You can also drag a clef
from the score to another clef of the score by using Shift + leftMouseButton +
Drag.

Add

Drag a clef from the palette onto an empty part of a measure. This creates a
clef at the beginning of the measure. Drag a clef to a particular note to
create a mid-measure clef. If the measure is not the first measure in the staff
it is drawn smaller.

Remove

Select a clef and press Del.

Note that changing a clef does not change the pitch of any note. Instead the
notes move to preserve pitch.

Drum notation

Example drum notation:

ododsdodsdod sl odsd o od o

Drums -H€E&—*

I A B

Cowhbell HFHH€ r

Notation for drumsets often include upstem and downstem notes happening
simultaneously. If are unfamiliar with editing multiple voices in a single staff
then see voices for an overview. See below for instructions specific to
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percussion notation.

MIDI keyboard

The easiest way to add drum notation to your score is via MIDI keyboard.
Most MIDI keyboard have percussion markings above each key. If you press
the key for high hat then MuseScore will add the correct notation to the
score. MuseScore automatically takes care of the stem direction and type of
note head.

Mouse

Note input via mouse is available in version 0.9.4 or later. Note entry for
unpitched percussion works differently than for other instruments, so here
are the special steps:

1. Select a note or rest in the percussion staff. Please note that the Drum
palette will remain empty until you have completed this step

2. Press "N" to begin note entry

3. Select a note duration from the Note Input toolbar

4. Select a type of note (such as bass drum or snare) from the drum
palette

5. Click on the percussion staff to add the note to the score

Grace note

Notation

Short grace notes (Acciaccatura) appear as small notes with a stroke
through the stem. Long grace notes (Appoggiatura) have no stroke. Both
are placed before the normal-sized main note.

Creation

Create a grace note by dragging a grace note symbol from the Grace Notes
palette (In versions 0.9.5 and earlier the palette is simply called Notes) to a
regular note on the score.

If you want to change the duration of a previously created grace note, select
it and choose a duration from the toolbar or enter with one of the keys 1 ... 9

(see note entry).

MNotes -]

[
FIPIPRE P

External links

¢ Grace note, Appoggiatura, and Acciaccatura at en.wikipedia.org
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Hairpin

Hairpins are line objects. To create a hairpin first select a note to mark the

start point.

* H: Creates a crescendo hairpin

* Shift+H: Creates a diminuendo hairpin (decrescendo)

You can also create hairpins by dragging a hairpin symbol from the line
palette to a note head.

1. H creates a crescendo hairpin:

e e

2. Double click switches to edit mode:

=
' [
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3. Shift+Right moves end anchor:
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Key signature

Key signatures are created or changed by dragging a key symbol from the

key palette to a measure or existing key signature.
Keys

EEE=E =
W S W
Weh W,
Wy =

Iy |
L5 *

F9 toggles the palette window.

Change
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Drag a key from the palette onto a key in the score.

Add

Drag a key from the palette onto an empty part of a measure. This creates a
key at the beginning of the measure.

Remove

Select a key and press Del.

Line

The lines palette like other palettes works via "drag-and-drop". Use the
mouse to drag the item from the palette and drop it onto the score.

[ Lines v]
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Change length

If you change the length of a line using the mouse then the anchor positions
(the notes or measures they apply to) do not change. Therefore the following
method is recommended for adjusting the start or end points of a line.

1. If you are in note entry mode then press N to leave note entry
2. Double click the line that you want to change
3. Move the handles using the following shortcuts

* Shift+Right to move the anchor right by one note (or measure)

* Shift+Left to move the anchor left by one note (or measure)

4. If you need to change the length visually without changing the notes or
measures that the line is anchored to then use the following shortcuts

* Right to move the handle right by one unit

* Left to move the anchor left by one unit

See also: Hairpin, Volta (1st and 2nd endings)

Measure rests
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Full-measure rest

When an entire measure is devoid of notes, a full-measure (full-bar) rest is
used.

To create a one-bar rest select a measure and press Del. All notes and rests
on this measure are then replaced by a one-bar rest.

Multi-measure rest
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Multi-measure (multi-bar) rests indicate a long duration of silence for an
instrument and are frequently used in ensemble sheet music.

Instructions

1. From the menu choose Style - Edit General Style (in versions 0.9.5 and
earlier it is called Style - Edit Style)
2. Click on the "Score" tab if it is not already selected

3. Add a check mark next to "Create Multi Measure Rests"

Limitations

The style option automatically creates multi-measure rests throughout the
score. Therefore it is recommended that you enter all your notes first and
then turn on multi-measure rests afterward.

Versions 0.9.5 and earlier do not automatically break multi-measure rests at
important points such as double bar lines, key signatures, rehearsal marks.
This is fixed for the latest versions of MuseScore. As a workaround for
earlier versions see the "Break multi-measure rests" heading of measure

operations.

Repeat

The start and end of simple repeats can be defined by setting appropriate
bar lines. For instructions on first and second ending measures see volta.

Playback

To hear repeats during playback make sure the "Play Repeats" I button on
the toolbar is selected. Likewise you can turn off repeats during playback by
deselecting the button.

In the last measure of a repeat you can set the property "Repeat Count" to
define the number of played repeats.
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Text

Repeat text such as "D.C. al Fine" or "D.S. al Coda" is located in the repeats

palette.
[ Repeats -]
# %
0 0
1] Fine
D.C. D.C. al Fine

DC alCoda D.S alCoda
D .5 al Fine D5

To Coda

Slur

A slur is a curved line between two or more notes that indicates they are to

be played without separation. If you mean to join two notes of the same
pitch, see Tie

Instructions

1. Leave note entry mode and select the first note:

1
|
I

SR

2. S creates a slur:

3. shift+Right moves the slur end to the next note:

5. Escape ends Slur Edit mode:

1
|
| I

e
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Adjustments

The boxes or handles (displayed in the images for steps 2-4 above) can be
adjusted with the mouse. The two outer handles adjust the start and end of
the slur. The two inner handles adjust the contour of the slur.

A slur can span several systems and pages. The start and end of a slur is
anchored to a note/chord or rest. If the notes are repositioned due to
changes in the layout, stretch or style, the slur also moves and adjusts in
size.

Note: It is not possible to change the start and end anchor notes using the
mouse. Use shift + left or right arrow keys to adjust the start and end points
of a slur.

Dotted line

Dotted slurs are sometimes used in songs where the presence of a slur varies
between stanzas. Dotted slurs are also used to indicate an editor's
suggestion (as opposed to the composers original markings). To change an
existing slur into a dotted slur right-click on it and choose Slur Properties....
From the Slur Properties dialog you can choose whether you want a solid or
a dotted slur.

See also: Tie, Edit mode.

Tie

A tie is a curved line between two notes of the same pitch. If you want a
curved line that spans multiple pitches see Slur.

First method

Select first note:
+ creates a tie: (In version 0.9.3 or earlier the shortcut is shift+S)

L

Second method

To create ties during note entry press + after the first note of the tie. In
version 0.9.3 or earlier you must press + before adding the first note.

34



Time signature

Time signatures are available in the main palette sidebar. You can drag
and drop the times signatures onto the score (see palette for general
information on working with palettes in MuseScore).

[ Time v]
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If you need a time signature not found in the sidebar palette then go to Create
- Time... to create your own. You can edit the upper and lower numbers in
the Create Ti ne Signature pane.

In most cases you'll only need to edit the first of the upper numbers. The
additional upper numbers are for additive meters which contain multiple
upper numbers separated by a plus sign.

| ¥ MuseScore: TimeSignature 'Z|
Creats Tanasignatire
— — 0 e . =
_%:_iz_i__i:_i_
EEr3E I
4 5 5 8 b S@c [SHo S#0 5

e b

Add

Pickup measures

There are occasions when the actual duration of a measure is different from
the duration specified by the time signature. Pickup measures are a common
example. To change the actual duration of a measure without displaying a
different time signature see the Properties section of measure operations.

Tremolo

Tremolo is the rapid repetition of one note or a rapid alternation between
two or more notes. It is indicated by strokes through the stems of the notes.
If the tremolo is between two or more notes, the bars are drawn between
them.
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The tremolo palette contains separate symbols for one note tremolos (shown
with stems below) and for two note tremolos (shown with no stem below).

Tremalo -

[
t$%-2¢

In a two note tremolo every note has the value of the whole tremolo duration.
To enter a tremolo with the duration of a half note (minim) first enter two
normal quarter notes (crotchets). After dragging a tremolo symbol to the
first note the note values automatically double to half notes.

Tuplet

Tuplets are used to write rhythms beyond the beat divisions usually
permitted by the time signature. For example, triplet eighth notes (quavers)
in a 4-4 time signature divide the quarter note (crotchet) beat into three
instead of two.

Instructions

To create a triplet first select a note on the score that specifies the full
duration of the triplet group. For example, a group of triplet eighth notes
(quavers) has a "full duration" of one quarter note (crotchet).
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From the main menu choose Notes - Tuplets - Triplet. This creates a triplet by

dividing the full duration into three equal parts,
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which cajn be further edited.
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Note entry mode

Tuplet entry works a little differently in note entry mode than the method
outlined above. In version 0.9.5 or later you must select duration first then
enter the pitches afterward. Below are step-by-step instructions for making
triplet eighth notes.

1. Switch to note entry mode by pressing n

2. Make sure the note entry marker is in the place that you want to start
the tuplet (use the right and left arrow keys if necessary)
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3. Choose the duration for the whole tuplet group from the note entry
toolbar. For this example click on the quarter note (or press 5 on the
keyboard)

4. From the main menu choose Notes — Tuplets - Triplet, or press Ctrl+3
(Mac: $+3)

5. Notice that an eighth note duration is automatically selected. Click on
the staff to add pitches

Properties

To change the display properties of a tuplet right click on the tuplet number

and choose Tuplet Properties....
| ¥ MuseScore: Tuplet Properties i]|

o [oc ][ cones ]

The number section of the properties dialog allows you to show one integer,
a ratio of two integers, or no number at all.

In the bracket section the "bracket" and "nothing" allow you to explicitly
show or hide the bracket. The "auto bracket" option hides the bracket for
beamed notes and shows the bracket if the tuplet includes unbeamed notes
or rests.

External links

¢ Triole at en.wikipedia.org

Voices

Voices allow you to have notes on a single staff which start at the same time
yet have different durations. Voices are sometimes called 'layers' in other
notation software.

Voice 1 (up-stem notas)

F Voice 2 (down-stem notes)
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Instructions
1. First start by entering the top voice (all the up-stem notes).

2. When you enter the notes some may have down-stems. If you are using
version 0.9.4 or later you do not need to worry about the stem direction
at this point because they will flip automatically when you add the

-

second voice. ] 1 =

3. If you are using a computer or MIDI keyboard to enter notes (instead of
the mouse), use the Left arrow key to move your cursor back to the
beginning.

4. Click on "Voice 2" button | * | and start entering the bottom voice (all the
down-stem notes).
5. When you are done it should look like this:

When to use voices

* If you need stems pointing in opposite directions within a chord on a
single staff

¢ If you need notes of different durations within a single staff, played
simultaneously

Hidden spacer rests

To hide a rest right-click on the rest and select Set Invisible. If you have Display
- Show Invisible marked then the rest still shows in gray on your screen. The
hidden rest does not appear when you print.

Volta

Volta brackets or first and second ending brackets are used to mark
different endings for a repeat.

1. 2. |

== eSS

To place a volta bracket on the score drag-and-drop the item from the lines
palette.

The brackets can span more than one measure. Double click the volta to
enter edit mode and then move the handles with:

* one measure right shift+Right
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¢ one measure left shift+Left

These commands move the "logical" start or end of the volta bracket which
determines playback in MuseScore and layout over multiple systems. Moving
the handles using the left or right arrows keys only or using the mouse
allows finer adjustments but does not change how the repeat is played.

If you move the handles, a dashed line from the logical position to the actual
position is shown

1. 3. b
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Text

You can change the text and many other properties of a volta bracket using
the Line Properties dialog. Right-click on a volta bracket and choose Line
Properties.... If you are using version 0.9.3 or earlier then choose "Volta
Properties..." The figure below shows the volta text as "1.-5."

[";’ MuseScore: Line Properties z‘]
Line:
Widsh: |0o18sp S Line styler [solid | Color: -
[ diagonaly
Begin Continue End
{0 Text 15 C' O Text - []5ymb.  Fed (Pedal) ]
place; Above |v place: |Above ¥ 0O0sp By | O.00sp -
O Syrb, Ped (Pedsl) C Syrb. Ped (Peds) [ Hock L0 | U
i ¥ s ¥
[ Hook | 1.00sp 3 Up
(o J[ cones ]
[1.-5. Il6. I
¥ || I [
i H | o | |
I _L. -
L s ¥ o —&
Playback

Sometimes a repeat plays for more than two times. In the figure above the
volta text indicates that it should play five times before it continues. If you
want to change the number of times MuseScore plays a repeat then go to the
measure containing the repeat bar line and change its Repeat Count (see
Measure operations for details).

In version 0.9.4 or earlier you can only place voltas on the top staff of a
multi-part score. Otherwise you may encounter bugs such as the MuseScore
crashing when you create parts (see bug report) or the anchor position
moving when you reload the score.

External links

e Screencast: Add alternative repeats with MuseScore 0.9.5
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Chapter 4

Sound and playback

MuseScore has "Sound and playback" capabilities built in. This chapter
covers the playback controls and ways to extend the instrument sounds
beyond the built-in piano sound.

Play mode

MuseScore has an integrated sequencer and synthesizer to play your score.

By pressing the Play b button you enter Play mode. In Play mode the
following commands are available:

* Seek to previous chord Left

* Seek to next chord Right

* Seek to previous measure Ctri+Left
* Seek to next measure Ctr/+Right

* Rewind to start of score Home

» Toggle show play panel F11

Press the play button again to stop and exit Play mode.

MuseScore starts playback from the place it last left off. If you select a note
then MuseScore starts from the newly selected note instead. The toolbar also
has rewind button to quickly return to the beginning of the score for
playback.

Play Panel

The Play Panel offers more controls over playback including tempo, starting
position, and general volume. From the main menu choose Display - Play Panel
to open the Play Panel.
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Troubleshooting

Version 0.9.5 or earlier: If you want to play instruments other than piano
you have to change the MuseScore integrated SoundFont with a more
capable one in Edit —» Preferences... - I/O tab. See SoundFont for instructions.

Sound on Ubuntu

If you are having difficulty with sound on Ubuntu then it is recommended to
upgrade to version 0.9.5 or later. Instructions for obtaining the latest release
are on the download page of the website. If you have further problems feel
free to use the forums.

SoundFont

MuseScore comes with a special type of file called a SoundFont that tells
MuseScore how to play each instrument sound. Some SoundFonts are
custom designed for classical music others for jazz or pop, others are large
and take up a lot of memory, still others are very small and light-weight. The
latest versions of MuseScore (version 0.9.6 or higher) come with a relatively
light-weight, general-purpose SoundFont called, "TimGM6mb.sf2".

Overview

A SoundFont file can store any number of instrument sounds. Many
SoundFonts are available on the web. Look for one that covers the 128
sounds of General MIDI (GM). If you use a SoundFont that does not conform
to the General MIDI standard then others may not hear the correct
instruments when you share the score or save as MIDI.

The file size and sound quality of SoundFonts available on the web varies.
Larger SoundFonts often sound better but may be too large to run on your
computer. If you find MuseScore runs slowly after installing a large
SoundFont or your computer can't keep up during play back then look for a
smaller SoundFont. Below are three popular GM SoundFonts of different
sizes.

* FluidR3 GM.sf2 (141 MB uncompressed), download
Fluid-soundfont.tar.gz (129 MB)

* MagicSF ver2.sf2 (67.8 MB uncompressed), see Big SoundFonts
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e TimGM6mb.sf2 (5.7 MB uncompressed), download modified
TimGM6mb.sf2 (Courtesy of Tim Brechbill)

Compression

Since SoundFont files are large they often are compressed into a variety of
formats including .zip, .sfArk, and .tar.gz. You need to decompress these files
before they can be used.

» ZIP is standard compression format supported by most operating
systems.

» sfArk is a compression format designed especially for compressing
SoundFont files. Use the special sfArk software to decompress it.

e .tar.gz is a popular compression format for Linux. Windows users can
use 7-zip which supports a wide variety of compression formats. Note
that you need apply decompression twice: once for GZip and once for
TAR.

MuseScore settings

After finding and decompressing a SoundFont do not double click to open it
since this does not set up MuseScore. Instead move the file to a folder of
your choosing, start MuseScore, and follow the instructions below.

Go to Display - Synthesizer. The initial SoundFont setting depends on which
operating system you are using.

* Windows: C. / Program Fi | es/ MuseScor e/ / sound/ Ti nGvbnb. sf 2

* Windows (64-bit): C. / Program Fi | es
(x86)/ MuseScor e/ / sound/ Ti navbrb. sf 2

* Mac OS X:
/ Appl i cati ons/ MuseScor e. app/ Cont ent s/ Resour ces/ sound/ Ti mGvbnb. sf 2

e Linux (Ubuntu): / usr/ shar e/ sounds/ sf 2/ Ti nGVbnb. sf 2

Click on the Open icon next to the SoundFont location and browse for your
new SoundFont (.sf2) file. In the open dialog browse and select your file;
then press Open.

Instructions for 0.9.5 or earlier

If you are using version 0.9.5 or earlier then go to Edit - Preferences... - I/O
tab.

The initial SoundFont setting is : / dat a/ pi anol. sf 2. Replace this with the
location of your new SoundFont (.sf2) file. Click on the Open icon to browse
for the file and open it .
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Click OK to apply changes and exit the preferences panel. Quit and and
reopen MuseScore for the changes to take affect.

Troubleshooting

If the toolbar play panel is greyed out or not visible follow the instructions
below to get your sound working again:

1. Make sure there is a check mark next to the Display - Transport menu
item. You can add or remove the check mark by clicking on the
corresponding menu item. If this step does not solve your problem
continue with the next step below

2. If the play panel disappears after changing the SoundFont go to Edit -
Preferences... - I/O tab and click OK without making any changes, After
restarting MuseScore the play panel should reappear. This is a known
bug with versions 0.9.3 or earlier.

If you are setting up a SoundFont for the first time please use one of the
recommended SoundFonts listed above.

If playback stutters then you computer is not able to handle the SoundFont
you are using. Two solutions:

1. Reduce the amount of RAM (memory) used by MuseScore by using a
smaller SoundFont. See list above for suggestions

2. Increase the amount of RAM available for MuseScore by quitting all
applications except MuseScore. If you still have problems and a large
SoundFont is important to you then consider purchasing more RAM for
your computer

Tempo

Play back tempo can be changed via the play panel or via tempo text in the
score.

Play panel
* Display the play panel: Display - Play Panel
* Change the Beats per Minute (bpm) using the Tempo (Tmp) slider

Tempo text
* Select a note to indicate where the tempo text should be created
* From the main menu: Create - Text... » Tempo...

e Press OK to finish
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Note that in versions 0.9.3 or earlier it is not possible to change the tempo
text or BPM from the initial Tempo Text dialog. However you can change
both of these after you add a tempo text to the score.

Existing tempo text can be changed by double clicking the text to enter edit
mode. You can use the F2 palette to add a quarter note or another duration
for a metronome mark in the tempo text.

Andante .= 75

Beats per minute (BPM) on existing tempo text can be adjusted by right
clicking on the text and selecting Tempo Properties...

Note: Playback of tempo text may be faster or slower than the specified BPM
if the tempo setting in the play panel is not set to 100 percent.

Change and adjust sounds

Mixer

The mixer allows you to change instrument sounds and adjust the volume,
panning, reverberation, and chorus for each staff. From the main menu
choose Display - Mixer to show the mixer.

| MuseScore: Part List = "D].|

Tumpet noresal
|'_| Mute: U Solo [ ] crumsst d)

Ry

Fluba-normal
[ Mute DSmDﬁ'.r.setG m
L x .

Sound: Recorder

Mute and Solo

Use the Mute check box to quickly silence certain staves. Alternatively use
the Solo check box to silence all staves except the staff you mark as "solo".

Dials

To turn a dials clockwise click and drag upwards. To turn a dial
counter-clockwise (anti-clockwise) click and drag downwards.

Sound

The sound drop-down menu lists every instrument supported by your current
SoundFont. This feature is not implemented in version 0.9.4 or earlier for
Windows, but fixed in version 0.9.5.

Change instrument

Although you can change the instrument sound, staff name, and staff
transposition separately, versions 0.9.6 or later allow you to change all of
these properties at once.

1. Right click on an empty part of the measure and choose Staff Properties...
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2. Click on Change Instrument

3. Choose your new instrument and click OK to return to the Staff
Properties dialog

4. Click OK again to return to the score

Mid-staff change

In MuseScore some instruments can change sounds midway through a piece.
For example strings can switch to pizzicato or tremolo and trumpet can
switch to muted trumpet. The following instructions use muted trumpet as
an example but the same principles apply to pizzicato or tremolo strings.

1. Select the first note of the muted section
2. From the main menu choose Create —» Text - Staff Text

3. Type Mute (or an equivalent indication such as Con Sordino). At this point
the staff text is for humans and does not affect playback in MuseScore

. Right-click on the staff text and select Staff Text Properties...

4
5. In the Staff Text Properties dialog mark the Channel checkbox
6. In the Staff Text Properties dialog select mute

7

. Click OK to return to the score
Every note after the staff text you added now sounds muted. To return to an

unmuted sound later in the piece follow the same guidelines as above except
type Open in step 3 and select normal in step 6.
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Chapter 5

Text

The previous chapter covers text that affects playback tempo, but there are
many other types of text available in MuseScore: lyrics, chord names,
dynamic markings, fingering, headings, plus many more. These are all
accessible from the main menu via Create - Text.

For short generic text use staff or system text. The difference between these
two texts is whether you want it to apply to a single staff or apply to the
whole system.

Text editing

Double click on text to enter edit mode:

In text edit mode the following commands are available:

ctri+B (Mac: #+B) toggles bold face

e Ctri+1 (Mac: #+/) toggles italic

e Ctrl+U (Mac: #+U) toggles underline

* Up start superscript or end subscript if in subscript mode

* Down start subscript or end superscript if in superscript mode
* mOVe Ccursor: Home End Left Right

e Backspace remove character to the left of the cursor

* Delete remove character to the right of the cursor

e Return start new line
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F2 Show text palette. The text palette can be used to enter special
characters and symbols.

Text palette:

MuseScore: Special Text Symbaols 1

Taxt Frame
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See also: Chord name, Lyrics, Frame, Edit mode

Text style

Text elements are created from a Text Style. This style defines the initial
properties of text.

Text properties:

Font Family: name of the font such as "Times New Roman" or "Arial"
Point Size: the size of the font in points

Italic, Bold, Underline: font properties

Anchor: page, time, notehead, system, staff

Alignment: horizontal: left, right, center; vertical: top, bottom, center
Offset: an offset to the normal anchor position

Offset Type: mm, space, or percent of page size

Text types:

Title, Subtitle, Composer, Poet: anchored to page

Fingering: Fingerings are anchored to note heads.

Lyrics: Lyrics are anchored to a time position.

Chord name: Chord names are also anchored to a time position.
System: Applies to all staves in a system.* Anchored to a time position.

Staff: Applies to a single staff in a system.* Anchored to a time position.

* The distinction between System and Staff text matters for ensemble scores.
System text will extract to all parts. Staff text will only extract to the part to
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which it is anchored.

Chord name

Chord names can be entered by first selecting a note and then pressing
ctri+K. This creates a chord name text object for the selected chord.

* Type Space to move to the next chord.
* Shift+Space moves to the previous chord.

* Ctrl+Space enters a space into the chord name text.

Chord names can be edited as normal text. To add a sharp type # and to add
a flat type b. These characters will automatically turn into proper sharp or
flat signs when you move to the next chord.

Jazz font

If you prefer a more handwritten appearance to the chord names in your
score then versions 0.9.5 and later include a jazz font option.

1. From the main menu choose Style - Edit General Style...
2. From the left pane select Chordnames

3. In the right pane replace the text stdchords.xml with jazzchords.xml

Fingering

Fingering can be added to notes by dragging a fingering character from the
fingering palette to a note head in the score. When a note head is selected
first, the fingering character can be added using a double click. Fingerings
are normal text which can be edited like any other text.

[ Fingering -]
D|1]|2]|3|4]5

p i m a c@
OOOG®OE

Lyrics
1. First enter notes
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Select first note
Type ctri+L and enter lyrics text for first note

Type Space at end of word to go next note

A

Type an hyphen - at end of syllable to go to next note. The syllables are
connected with a dash

6. Shift+Space moves to the previous note

7. Enter (Mac: Return) moves down to the next lyric line

Mg T £

P P

- des - e, fii- = del - es,
Can - tet nunc hym - nos
Er - go qui na - tus

; I " - = ; o g z
\% 7] ]

Syllables can be extended by an underline:

o —

04 | |

" |
& . —

|
soul, To

T J! #
il O - ]

ulf ¥
Entered with: soul, __To Esc.

Special characters

Lyrics can be edited as normal text with the exception of a few characters. If
you want to add a space, hyphen or underscore to a single syllable then use
the following shortcuts.

* Ctrl+Space (Mac: ~~+Space) enters a space into the lyrics text
e Ctrl+- (Mac: ~«+-) enters a hyphen (- ) into the lyrics text

* Mac only: ~~+_ enters an underscore (_) into the lyrics text

See also: Text, Chord name.
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Chapter 6

Formatting

Break or spacer

Page breaks or line breaks (system breaks) are applied by dragging the
corresponding symbol from the breaks palette to an empty space of a
measure in the score. The break happens after the marked measure. The
green break symbols are visible on the screen but do not appear on
printouts.

[ Breaks/Spacer v]

Mid-measure system breaks are sometimes needed (especially for strophic
hymns or lieder). For example, if you want three beats on one system and a
one beat pickup on the next system, then you need to create two measures
with a shortened duration. For details see Measure operations, "Duration"

and "Irregular" sections.

Spacers are used to increase the space between two adjacent staves. Drag
and drop a spacer to a measure above the area that needs more vertical
space. Double click on the spacer and drag the handle using the mouse to
adjust the height of the spacer.

If you want to adjust the space between staves score-wide then use the style
settings. Spacers are designed for local adjustments.

Frame

Frames provide empty space outside of normal measures. They can also
contain text or pictures. MuseScore has two kinds of frames:

Horizontal
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Horizontal frames break a system. The width is adjustable and the height
equals the system height. Horizontal frames can be used to separate a

coda.
Vertical
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Vertical frames provide empty space between or before systems. The
height is adjustable and the width equals the system width. Vertical
frames are used to place title, subtitle or composer. If you create a title,
a vertical frame is placed before the first measure automatically if it is
not there already.

Create a frame

First select a measure. The command to insert a frame is found in the menu
Create - Measures . The frame is inserted before the selected measure.

Delete a frame

Select the frame and press Del.

Edit frame

Double click the frame to enter edit mode. A handle appears which can be
used to drag the size of the frame.

Title frame in edit mode:
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Image

You can use images to illustrate scores or add symbols that are not included
in the standard palettes.

To add an image drag-and-drop an image file onto the score. MuseScore
supports PNG and JPEG files and simple SVG files. MuseScore does not
support SVG shading, blurring, clipping or masking.
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Chapter 7

Advanced topics

Cross staff beaming

In piano scores it is common to use both staves (bass and treble clef) to write
a musical phrase.
This can be entered in MuseScore as follows:

First enter all notes in one staff:

i

Ctrl+Shift+Down moves the selected note or chord to the next staff (Mac:
¥ +Shift+Down.)

i

See also: Bar line for cross-staff bar lines (i.e. grand staff).

Part extraction

If you have written a full ensemble score, MuseScore can create sheet music
that shows only the individual part for each musician in the ensemble.
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In current versions of MuseScore, the process of extracting parts from a full

score involves two main steps:

1. Specifying which instruments are included in each part ("Defining the

parts")
2. Actually creating the part

Defining the parts
You can define the parts at any point after creating a new score. You only

need to define the parts once for each score, but of course you can come
back and make changes if needed. The following instructions use a string

quartet as an example but the same principles apply for any other ensemble.

From the main menu choose File - Parts...

[ MuseScore: Parts @]
Select Part: Edit Part:
Irestr nt:
Delete Hew
x
In the Parts window click New to create a "part definition"
MuseScore: Parts @|
Selpct Part: Edk Part:
Part-1 Fila hlame: | pait-1
Part Titke:
Istrument;
H ign
iokn
vicla
ekl
(e ]
[cmserat)

In the right pane, type the words you want to use for the "File Name"

and "Part Title"

File Name

The initial name used when you save the part on your computer

(required)

Part Title
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The text printed on the first page of your part, top left corner

(optional)

4. Pick the instrument that you want to appear in your part by marking the
relevant box in the right-hand pane. Usually you only want one
instrument per part, but sometimes you might need a part that includes
more than one instrument (such as multiple percussion staves).
MuseScore lets you mark as many instruments per part as you need.

[ MuseScore: Parts

&)

Sedect Part: Edit Part:

Part-1 Fils Nama: | Quartet Y1
Part Tithe: | Wackin 1
Iresbrument;
(] ¥iokn
L] viokn
[ ] “iols
[] iokncelo

[ rew ]

Craate Pact

5. Repeat steps two through four (above) for each part as needed

| MuseScore: Parts

a=]

Sedect Part: Edit Part:
Qm:::_:; File Hatm: | Quartet_tc
Quartit_a Part Tk Cella
Queartet_Ye

Iresbrument:

[ ] tiobn

(] vickn

[] viola

[~ I¥ikoncellc
[ rew ]
Craate Pat |

6. Once you done, press Close to dismiss the Parts window

You have now finished defining the parts. You do not need to do this again
unless you add or remove an instrument from your full score. In current
versions of MuseScore it is not possible to split a single staff (that contains
two or more voices) into separate parts. So, any instrument that you want to
print out a separate part for also needs to have its own staff in the full score.

This may require some planning.

Creating the parts

You can create your parts at any time to see how they look, but it is best to
do it once you have the full score written out, or even once you have at least
some music input and want to check and see how your parts will look:

1. From the main menu choose File - Parts... to return to the Parts window.
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2. In the left pane, click to select a part that you want to create and view

3. Press Create Part and a new tab is added to the main MuseScore window
containing your newly created part

Repeat steps two and three for each part that you want to view or print. If
you make any changes to the full score you can re-create a part at any time
in order to show the new changes in the part.

Saving

In current versions of MuseScore changes on a score are not linked to parts
that have already been created, so any change you make on the score will
also need to be made on the individual part either manually or by recreating
the part from the steps above. Also, parts are created as not-yet-saved files,
so each part you just created needs to be saved as an individual file (via File »
Save...) or it will be lost when closing the tab. Usually you may want to review
it before saving to check for proper formatting.
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Chapter 8

Support

This chapter describes how to find help using MuseScore: the best places to
look, the best way to ask a question on the forums, and tips for reporting a
bug.

How to report bug or ask for support

Before posting your support request in the forum:

e PLEASE, look for a solution in the user handbook.

* Use the search function of the website to see if someone has already
encountered the same problem on the forums.

» If you are posting an error report, first try to reproduce the problem
with the latest prerelease. You may also view the version history to check
whether it has been fixed already.

When posting your request for support or bug report, please include as much
of the following information as you know:

* Version of MuseScore you are using (e.g. version 0.9.5) or the revision
number if you are using a prerelease (e.g. revision 1944)

* Operating system you are running it on (e.g. Windows Vista, Mac OS
10.5 or Ubuntu 9.04)

» If you are reporting a bug, please describe the precise steps that lead to
the problem (where do you click, what keys do you press, what do you
see, etc.). If you are not able to reproduce the problem with the steps, it
is probably not worth reporting it as the developers will not be able to
reproduce it (and solve) either.

* Limit your reports in the issue tracker to one bug per report

* Remember that the goal of a bug report is not only to show the bug but
to allow others to reproduce the bug easily
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Known incompatibilities

Hardware incompatibilities
The following software is known to crash MuseScore on startup :

* Samson USB Microphone, driver name "Samson ASIO Driver",
samsonasiodriver.dll. More info

* Digidesign MME Refresh Service. More info

Software incompatibilities

* Maple virtual cable is known to prevent MuseScore to close properly.

* KDE (Linux) window settings can cause the whole window to move when
dragging a note. Changing the window settings of the operating system
avoids the problem.

Font problem on Mac OS X

MuseScore is known to display notes as square when some fonts are
damaged on MacOS X.
To troubleshoot this issue :

1. On your mac, go to Applications -> Font Book

2. Select a font and press Cmd + A> to select them all
3. Go to File -> Validate Fonts
4

. If any font is reported as damaged or with minor problems, select it and
delete it

5. Restart MuseScore if necessary

Revert to factory settings

Recent versions of MuseScore have the option to revert back to the standard
built-in presets or "factory-settings". Sometimes this is helpful if your
settings are corrupted. This is not a normal occurrence so it is best to
consult the forums first since there maybe a way to solve your problem
without resetting everything.

Warning: reverting to "factory settings" removes any changes you have
made to the preferences, palettes, or window settings.

Instructions for Windows
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1. If you have MuseScore open then you need to close it first (File - Quit)

2. Type Windows key+R to open the Run dialog. (The Windows key is the one
with the logo for Microsoft Windows.)

3. Click Browse...

4. Look for mscore.exe on your computer. The location may vary
depending on your installation but it is probably something similar to My
Computer > Local Disk > Program Files > MuseScore > bin >
mscore.exe

5. Click Open to leave the Browse dialog and return to the Run dialog. The
following text (or something similar) should display in the Run dialog:
"C.\ Program Fi | es\ MuseScor e\ bi n\ mscor e. exe"

6. Click after the quote and add a space followed by a hyphen and a
capital F: -F
7. Press OK

After a few seconds MuseScore should start and all the settings reverted to
"factory settings".

For advanced users, the main preference file is located at:

* Windows Vista or later:
C:. \ User s\ <USERNAME>\ AppDat a\ Roam ng\ MusE\ MuseScor e. i ni

 Windows XP or earlier: C: \ Docunent s and
Set t i ngs\ USERNANVE\ Appl i cati on Dat a\ MusE\ MuseScor e. i ni

The other preferences (palette, session...) are in:

* Windows Vista or later:
C: \ User s\ <USERNAME>\ AppDat a\ Local \ MusE\ MuseScor e\

* Windows XP or earlier: C:\ Docunent s and Settings\ USERNAVE\ Local
Set tings\ Appl i cati on Dat a\ MusE\

Instructions for Mac OS X
1. If you have MuseScore open then you need to quit the application first
(File = Quit)
2. From the Open Applications/Utilities/Terminal and a Terminal session
window should appear

3. Type, (or copy/paste) the following command into your terminal line
(include the '/* at the front):

/ Appl i cati ons/ MuseScor e. app/ Cont ent s/ MacOS/ nscore -F

This resets all MuseScore preferences to factory settings and immediately
launches the MuseScore application. You can now quit Terminal, and
continue using MuseScore.

59


http://en.wikipedia.org/wiki/windows_key

For advanced users, the main preference file is located in

~/ . confi g/ muse. org/ MuseScore.ini.

The other preferences (palette, session...) are in ~/ Li brary/ Appl i cati on
Support/ Musk/ MuseScor e/

Instructions for Linux (please adapt for flavors other than
Ubuntu)

1. If you have MuseScore open then you need to quit the application first
(File - Quit)

2. From the Ubuntu main menu choose Applications — Accessories — Terminal.
A Terminal session window should appear

3. Type, (or just copy/paste) the following command into your terminal
line:

mscore -F
This resets all MuseScore preferences to factory settings and immediately

launches the MuseScore application. You can now quit Terminal, and
continue using MuseScore.

For advanced users, the main MuseScore preference file is located at
~/ . confi g/ MusE/ MuseScor e. i ni
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Chapter 9

Appendix

Glossary

The glossary is a work in progress, please help if you can. You can
discuss about this page on the documentation forum

The list below is a glossary of frequently used terms in MuseScore as well as
their meaning. Translators of this page, should be adding the translation for
each term.

Acciaccatura
A short grace note. See —grace note
Accidental

Accidentals appear in front of notes and shift their pitch.

Accidentals are used to alter the pitch of a note within a piece; the same
symbols as in the —key signature are used, but they are placed before a
particular note. Accidentals are for example sharps, flats and naturals.
Accidentals affect all notes on the same staff position for the remainder
of the measure in which they occur, but it can be cancelled by another
accidental.

Anacrusis

Incomplete first measure of a piece or a section of a piece of music.
Appoggiatura

A long grace note. See —grace note
Bar Lines

Vertical line through a staff or the system that separates measures .

Beam
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Notes with a duration of an eighth or smaller either carry a flag or a
beam. Beams are used for grouping notes.

BPM

See —»metronome mark

Breve

A double whole note or breve is a note that has the duration of two
whole notes.

Chord

The minimal definition of a chord is a minimum of two different notes
played together. Chords are based on the choices made by a composer
between harmonics of one, two or three (and more) fundamental sounds.
Ex. In the chord of C, G is the second harmonic, E the fourth of the
fundamental C. Now in C7, the B flat is the 6th harmonic of C and in C
Maj7 B is the second harmonic of E and the fourth harmonic of G...

Clef

Sign at the beginning of the Staff, used to tell which are the musical
notes on the lines and between the lines.

There are 2 F Clefs, 4 C Clefs and 2 G Clefs: F third, F fourth, C first, C
second, C third, C fourth, G first, G second (known as treble key too).
G first and F fourth are equivalent.

Clefs are very useful for transposition.

Crotchet

A crotchet is the British english term for what is called a quarter note
in American english. It's a quarter of the duration of a whole note
(semibreve).

Demisemiquaver
Thirty-second note
Duplet (engl.)
See —tuplet
Eighth note
Its duration is eighth of a whole note..
Flag

See —»beam.
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Flat

Sign which indicates that the pitch of a note has to be lowered one
semitone.

Grace note

Grace notes appear as small notes in front of a normal-sized main note. A
short grace note (acciaccatura) has a stroke through the stem, A long
grace note (appoggiatura) does not.

Hemidemisemiquaver
Sixty-fourth note

Key Signature

Set of sharps or flats at the beginning of the staves. It gives an idea
about the tonality and avoids to repeat those signs all along the staff.
A Key Signature with B flat means F major or D minor tonality.

Longa
A longa is a quadruple whole note.
Metronome mark

Metronome marks are usually given by a note length equalling a certain
playback speed in bpm. Beats per minute (BPM) is the unit for measuring
tempo. In MuseScore, metronome marks are used in tempo texts.

Minim

A minim is the British term for a half note. It has half the duration of a
whole note (semibreve).

Natural

A natural is a signs that cancel some alteration on notes of the sama
pitch.
See alterations.

Part

Music to be played or sang by one or a group of musicians. In a string
quartet, 1st part = Violin 1, 2nd part = Violin 2, 3rd part = Alto, 4th part
= Cello.

Quaver

The british quaver is what is called in American eighth note. It has on
eighth the duration of a whole note.
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Quadruplet
See —tuplet
Quintuplet
See —tuplet
Rests
Interval of silence of a specified duration.
Semibreve

A semibreve is the british term for a whole note. It's last's a whole
measure in 4/4 time.

Semiquaver
Sixteenth note

Semihemidemisemiquaver (Quasihemidemisemiquaver)
Hundred twenty-eighth note

Sextuplet
See —tuplet

Sharp

Sign which indicates that the pitch of a note has to be raised one
semitone.

Slur

Tie and Slur are two words used to define a curved line between two or
more notes. Slur means that the notes will be played without attack (
legato ). Tie is used between two or three ( rare ) same notes to indicate
its duration:

Quarter note + Tie + Quarter note = Half note,

Quarter note + Tie + Eighth note = Dotted Quarter note

Quarter note + Tie + Eighth note + Tie + 16th note = Double Dotted
Quarter note

Staff (Staves)

Group of one to five horizontal lines used to lay on musical signs. The
staff appeared in the XIth Century with 4 lines (Gregorian notation).

System
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System: Set of staves to be read simultaneously in a score.

Operating System (OS): Set of programs written in the aim to set up a
computer from a lot of electronic components. Popular OS are Microsoft
Windows, Mac OS X, and GNU/Linux.

Tie
See -slur.
Triplet (engl.)
See —tuplet

Tuplet

A tuplet divides it's next higher note value by a number of notes other
than given by the time signature. For example a triplet divides the next
higher note value into three parts, rather than two. Tuplets may be:
triplets, duplets, quintuplet, and other.

Voice

Polyphonic instruments like Keyboards, Violin(s) or Drums, need to write
notes of different duration at the same time on the same Staff. To write
such things each horizontal succession of notes has to be written on the
staff independently.

Volta

Keyboard shortcuts

Keyboard shortcuts can be customized via Edit » Preferences... » Shortcuts tab
(Mac: MuseScore - Preferences... - Shortcuts tab). Below is a list of of the initial
shortcut settings.

Navigation

Beginning of score: Home
Last page of score: End

Next page: Pg Dn
Previous page: Pg Up

Next measure: Ctrl+Right
Previous measure: Ctri+Left

Next note: Right
Previous note: Left
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Note below (within a chord or on lower staff): Alit+Down
Note above (within a chord or on higher staff): Ait+up

Top note in chord: ctri+Alt+Up (Ubuntu uses this shortcut for Workspaces
instead)

Bottom note in chord: Ctri+Ait+Down (Ubuntu uses this shortcut for
Workspaces instead)

Note entry

Begin note entry mode: N
Leave note entry mode: N or Esc

Duration
For a list of shortcuts for each duration (such as quarter note, eighth note,
etc.) see note entry.

Half duration of previous note: Q
Double duration of previous note: w

Voices

Voice 1: Ctri+1, Ctrl+1
Voice 2: Ctrl+l, Ctrl+2
Voice 3: Ctri+I, Ctrl+3
Voice 4: Ctrl+l, Ctrl+4

Pitch

Pitches can be entered by letter name or MIDI keyboard. See note entry for
full details.

Repeat previous note: R

Raise pitch by octave: Ctri+Up
Lower pitch by octave: Ctri+Down

Raise pitch by semi-tone: up
Lower pitch by semi-tone: Down

Add sharp to note: (undefined due to conflicts with zooming)
Add flat to note: -

Rest: 0 (zero). In versions 0.9.6 and earlier, Rest: Space

Interval

Add interval above current note: Ait+[Number]
Add interval below current note: Shift+[Number]

Direction

Flip direction (stem, slur, tie, tuplet bracket, etc): x
Mirror note head: shift+X
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Articulations

Tie: +

Slur: s

Staccato: shift+.
Crescendo (hairpin): H
Decrescendo: Shift+H

Lyric entry

Previous lyric syllable: Ctri+Left
Next lyric syllable: Ctri+Right

Up to previous stanza: Ctri+Up
Down to next stanza: Ctrl+Down

For more lyric shortcuts see lyrics

Display

Navigator: F12 (Mac: ~~+%+N)
Play Panel: F11 (Mac: ~~+%+P)
Palette: F9 (Mac: ~~+%+K)
Mixer: F10 (Mac: =+ 3%+M)

Licensed under the Creative Commons Attribution 3.0 license, 2002-2011

Werner Schweer and others.

@0-
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